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About This Book

The IBM Network Station Runtime Environment for RS/6000 User's Guide provides
instructions for users of IBM Network Stations in the RS/6000 environment.

How To Use This Book
These chapters and appendixes are included:

� Chapter 1, “Introduction” on page 1 introduces the network computing model,
Common Desktop Environment (CDE), and X Display Manager (XDM).

� Chapter 2, “Sessions” on page 3 describes powering on the IBM Network
Station, choosing a host, logging in, and logging out. The chapter also offers
problem determination information.

� Chapter 3, “Using the IBM Network Station Manager Program” on page 7
describes the setup and management tasks associated with one or all of your
IBM Network Stations and IBM Network Station users. It gives an overview of
Network Station Manager and explains how to start the program, work with the
program, and view the error messages.

� Chapter 4, “Running Applications on Network Station in the CDE/XDM
Environment” on page 29 provides information about local clients and utilities
on the IBM Network Station running in the CDE/XDM environment.

� Chapter 5, “Running Applications on Network Station in the Common Login
Environment” on page 33 provides information about local clients and utilities
on the IBM Network Station running in the Common Login Environment.

� Appendix A, “Advanced CDE/XDM Session Configuration” on page 55
discusses configuring your CDE desktop to open a local client when you select
its icon.

� Appendix B, “Running Java Applets and Applications under CDE/XDM
Environment” on page 59 describes procedures for launching Java applets and
applications.

� Appendix C, “More about CDE” on page 63 offers additional information about
CDE.

� Appendix D, “CDE Action” on page 65 lists CDE Actions (information needed if
you want to create an icon to launch applications from the CDE desktop).

 Highlighting Conventions
These highlighting conventions are used in this book.
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Bold Identifies commands, subroutines, files, structures,
directories, and other items whose names are predefined
by the system. Also identifies graphical objects such as
buttons, labels, and icons that the user selects.

Italics Identifies parameters whose actual names or values are to
be supplied by the user.

Monospace Identifies examples of specific data values, examples of text
similar to what you might see displayed, examples of
portions of program code similar to what you might write as
a programmer, messages from the system, or information
you should actually type.

 ISO 9000
ISO 9000 registered quality systems were used in the development and
manufacturing of this product.

 Related Publications
The IBM Network Station Runtime Environment for RS/6000 User's Guide is
provided in PostScript and HTML format. We recommend that if you want to print
the User's Guide, print the /usr/netstation/doc/UserGuide.ps  file. If you want to
read the documentation online, view the /usr/netstation/doc/UserGuide.html  file.
The documentation for IBM Network Station Runtime Environment for RS/6000 also
includes the IBM Network Station Runtime Environment for RS/6000 System
Administrator's Guide.

The IBM Network Station Runtime Environment for RS/6000 documentation is
available only on the installation media and from the following World Wide Web
page :

http://www.as4ðð.ibm.com/networkstation/rs6ððð

The documentation is not separately orderable.

You may also find these books useful:

For additional information about the IBM Network Station:

� IBM Network Station Use (SA41-0036). Information about the IBM Network
Station hardware, valid for all platforms.

� IBM Network Station documentation for the AS/400 platform:

– IBM Network Station Manager for AS/400 (SC41-0632)

� IBM Network Station documentation for the S/900 platform:

– IBM Network Station Manager for S/390 (SC31-8546)
– IBM Network Station—Getting Started (SG24-4954). While this book was

written for IBM Network Station in the S/390 environment, much of the
information applies to all platforms.

For information about installing and managing the AIX operating system and
TCP/IP:

� AIX Version 4.2 Installation Guide (SC23-1924)
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� AIX Version 4 System Management Guide: Operating System and Devices
(SC23-2525)

� AIX Version 4 System Management Guide: Communications and Networks
(SC23-2526)

For information about printing in the AIX environment:

� AIX Version 4 Guide to Printers and Printing (SC23-2783)

� Adapters, Device, and Cable Information for Micro Channel Bus Systems
(SC23-2764)

For information about X Windows:

� AIXWindows Desktop Advanced User's and System Administrator's Guide
(SC23-2671)

� Volume 8: X Window System Administrator's Guide (Sebastopol, CA: O'Reilly &
Associates, Inc.)

For information about the CDE:

� AIX V4.1 CDE: User's Guide (SC23-2793)

� AIX V4.1 CDE: Advanced User's and System Administrator's Guide
(SC23-2795)

� AIX V4.1 CDE: Application Builder User's Guide. (SC23-2785)

� AIX V4.1 CDE: Desktop Kornshell User's Guide (SC23-2786)

� AIX V4.1 CDE: Help System Author's and Programmer's Guide (SC23-2787)

� AIX V4.1 CDE: Programmer's Overview (SC23-2789)

� AIX V4.1 CDE: Programmer's Guide (SC23-2790)

� AIX V4.1 CDE: Style Guide & Certification Checklist (SC23-2791)

� AIX V4.1 CDE: Internationalization Programmer's Guide (SC23-2788)

� AIX V4.1 CDE: ToolTalk Messaging Overview (SC23-2792)

� AIX V4.X CDE: ToolTalk and Open Protocols (SR23-7352)

For information about the ICS Webserver (Domino GO):

� Webmaster's Guide (GC31-8287)

Books identified with an order number (for example, SC23-2526) may be ordered
as described below.

 Ordering Publications
You can order publications from your sales representative or from your point of
sale.

Use AIX and Related Products Documentation Overview for information on related
publications and how to obtain them. The AIX and Related Products Documentation
Overview is available:

� On the World Wide Web. Using your web browser, go to the IBM Home Page
by opening the following URL:

http://www.ibm.com/
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On the IBM Home page, search on "AIX and Related Products Documentation
Overview" to access the publication.

� In the Hypertext Information Base Library Version 1 for AIX. This online
documentation is designed for use with the InfoExplorer hypertext retrieval
system.

� As a hardcopy publication; use order number SC23-2456.
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 Chapter 1. Introduction

Network Computing Overview
Until recently, there have been two computing alternatives available at the
desktop—a nonprogrammable terminal connected to a multi-user computer, or a
personal computer. Nonprogrammable terminals are simple, low-cost and reliable,
but limited in what they can do. Personal computers offer tremendous flexibility, but
are more complex and expensive to set up, connect, and manage.

Now there's a real alternative—the IBM Network Station, IBM's first network
computer, which combines the simplicity and low cost of nonprogrammable
terminals with leading-edge application technologies.

IBM Network Stations are nonprogrammable workstations with PowerPC
microprocessors that allow the network computers to connect to an RS/6000
server. The server downloads information needed to let the IBM Network Stations
select a host machine and log in to that machine.

Once connected, IBM Network Station users have access to all kinds of
applications running on one server or many servers, to the worldwide resources of
the Internet (or a private intranet), and to the fast-emerging world of Java applets
and applications downloaded on demand from Internet or intranet servers.

 Environments Overview
When you're working on an IBM Network Station in an RS/6000 environment, your
system will be configured so that you're working in either the Common Login
Environment, Common Desktop environment (CDE), or in an X Display Manager
(XDM) environment.

Common Desktop Environment (CDE)
The CDE is a user-friendly graphical interface to the AIX operating system. By
making selections from the Front Panel (toolbar) at the bottom of the CDE desktop,
you can run applications (for example, the calendar, text editor, and mail
programs), manipulate files, and start LAN applications. Appendix C, “More about
CDE” on page 63 describes CDE in more detail.

CDE includes extensive Help; select the Help icon from the CDE Front Panel to
access the help system.

These resources are available to introduce CDE:

� AIX V4.1 CDE: User's Guide (SC23-2793)

� AIX V4.1 CDE: Advanced User's and System Administrator's Guide
(SC23-2795)

Additional resources are listed in “Related Publications” on page vi.

You can also link to the CDE web page for information and instructions, FAQs, and
other hints and tips. The URL is:

  Chapter 1. Introduction 1



  
 

http://www.rs6ððð.ibm.com/software/OS/CDE/

X Windows Display (XDM)
XDM is an X Window System session manager that by default, uses the Motif
Window Manager (MWM) to manage its windows. MWM lets you control elements
of window state, for example placement, size, icon/normal display, and input-focus
ownership. MWM also allows you to perform session management functions, such
as stopping a client.

In the X environment, the system administrator usually sets up pull-down menus
that allow you to perform tasks like starting applications and opening terminal
emulation sessions.

More information on configuring Motif Window Manager and login via XDM is
available in InfoExplorer; search on xdm and mwm.

Common Login Environment
The Common Login Environment is a desktop that is supported by all server
platforms that serve the IBM Network Station. This environment is the strategic
login environment for running, supporting, and managing client applications on the
IBM Network Station. The Network Station Manager and the Common Login
Environment are designed and integrated together to provide a standard runtime
environment and management interface for the Network Station.

The Common Login Environment uses the Network Station local window manager,
which is a light-weight window manager based on the Motif Window Manager
(MWM).

A menu bar will be available for starting applications, locking the screen, logging
out, and so on. This menu bar and the rest of the desktop environment are
managed by the Network Station Manager. Users can customize their desktop
environment by using the Network Station Manager. Please refer to Chapter 3,
“Using the IBM Network Station Manager Program” on page 7 and Chapter 5,
“Running Applications on Network Station in the Common Login Environment” on
page 33 for more detail.
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 Chapter 2. Sessions

 Getting Started
Getting up and running on your IBM Network Station requires two steps:

1. Powering on your IBM Network Station.
2. Logging in to the host server.

Powering on your IBM Network Station
You start up your IBM Network Station by setting the power switch to On. The unit
performs a self check, connects to the server, and downloads information needed
to receive a login from a network host machine.

During the power-on sequence, you'll see on the display the IBM logo, boot monitor
version, video memory check, DRAM memory check, MAC address, boot monitor
display resolution, and server display resolution. You'll see the IBM Network Station
search for its host server system; once it's located the host AIX server system, the
kernel file is downloaded. A graphical progress indicator tracks the download.

After the kernel is downloaded, the screen refreshes, then you'll see the copyright,
followed by a line of periods, indicating that the configuration and font files are
being read.

When the IBM Network Station has finished its boot process, a login window
appears on the display.

Logging in to the host
The login window is specific to the host where the Network Station is booted from
and is either a CDE login window, XDM login window, or a Common Login window.
Each presents its own specialized environment, composed of specialized
configuration files, initialization files, environment variables, and its own user
interface.

 CDE
A login chooser window will be on the display. If you choose a host from the login
chooser menu and select the OK button, the login chooser disappears and a new
login window appears.

The CDE login window has one text area for input in its initial window and four
buttons, labeled OK, Start Over , Options , and Help .

 XDM
A login chooser window will be on the display. If you choose a host from the login
chooser menu and select the OK button, the login chooser disappears and a new
login window appears.

  Chapter 2. Sessions 3



  
 

The XDM login window has two text areas in the initial screen (for inputting name
and password) and two buttons, labeled Use system default login  and Cancel
Session .

Common Login Environment
The Network Station login window has one text area for input in its initial window
and four buttons, labeled OK, Start Over , Roam , and Help .

Figure 1 shows the initial IBM Network Station login screen.

Figure 1. IBM Network Station Login Screen

At the initial IBM Network Station login screen, type your user name and press
Enter. Type your password and press Enter.

The buttons within the menu bar are:

 � Ok

Clicking Ok sends request to server for processing.

 � Start Over

Clicking Start Over prompts for userid and password.

 � Roam

Clicking Roam allows you to specify the network server to log into.

 � Help

Clicking Help allows you to access Help for the IBM Network Station Manager
program.

Note:  The mouse must be inside the window to make the window active.

Figure 2 shows the IBM Network Station menu bar, which contains the available
applications to select. If any applications were specified to autostart by the IBM
Network Station Manager, they will appear on your screen. If no applications were
set to autostart, select any applications that appear in your menu bar. Additional
available application buttons are: 5250, the IBM Browser, the Navio NC Browser,
and NSterm.

Hide 3270

Figure 2. IBM Network Station Menu Bar
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The buttons within the menu bar are:

 � Log Out

Clicking Logout logs you off the IBM Network Station.

 � Hide

Clicking Hide makes the menu bar float out of view when you move the mouse
pointer off the menu bar. To retrieve the menu bar, move your mouse pointer to
the very bottom of your screen (If you clicked the Move to Top  button, go to
the very top of the screen instead). This is useful if the menu bar covers part
of an application window. Clicking the Hide  button changes the button to Show
and keeps the menu bar displayed on the screen

� Move to Top

Clicking Move to Top  moves the menu bar to the top of the screen. The button
will read Move to Bottom  after the menu bar moves to the top. Clicking the
Move to Bottom  button, once the menu bar is located at the top, moves the
menu bar back to the bottom.

 � Other buttons

Other buttons on the menu bar will be applications available to select and use.

 � Lock Screen

The Lock Screen  button allows you to lock the screen when you leave the
Network Station. You will be prompted for a lock screen password.

Whichever login window is displayed, enter your user ID and password as
prompted, and press the OK button to complete the login process.

When the login process is successfully done, a dialog box will be displayed with a
DONE button. Click on the DONE button to proceed with the Common Login
Environment.

 Logging out
Logout procedures depend on how your system administrator has set up your IBM
Network Station.

 CDE
If you're working in the CDE environment, logout is initiated when you select the
EXIT icon from the Front Panel. Depending on how your system has been
configured and on the preferences you've set, you may be prompted to confirm that
you want to log out.

 XDM
If your initial login was via the XDM login window, you can log out from your root
menu. Press the right mouse button while the cursor is in the root window
(background of your display), then select End session -> Quit  from the root menu.

  Chapter 2. Sessions 5



  
 

Common Login Environment
If your initial login was via the Common Login window, select Log Out from the
menu bar to log off the IBM Network Station.

Hide 3270

Figure 3. IBM Network Station Menu Bar

 Problem determination
Both CDE and XDM have built-in problem determination tools.

For example, if for some reason you're unable to log in to CDE, you can select the
Options  button from the main login screen, then select Session , then Failsafe .
Log in as usual; you'll be in a very minimal environment, with one aixterm session
and a window manager. You can view your $HOME/.dt/startlog  and
$HOME/.dt/errorlog  files to look for login errors and configuration problems.

If you have similar login problems with XDM, select Use system default login  from
the XDM login window. This will give you a minimal environment with one aixterm
session and a window manager. You can access your $HOME/.xerrors  file, which
contains login error messages.

If you have similar login problems in the Common Login Environment, check if the
NSLD server is running on the AIX server by typing on the command line:

ps -fe | grep nsld

and contact your System Administrator.
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Chapter 3. Using the IBM Network Station Manager Program

The IBM Network Station Manager program is a browser-based application
program. This application program allows you to perform the setup and
management tasks that are associated with one or all of your IBM Network Stations
and IBM Network Station users. Setup Tasks are:

 � Hardware configuration:

Examples of configurable Hardware settings are: specifying primary mouse
buttons (left or right-handed), mouse pointer speeds, screen savers, desktop
background, and more.

� Startup application and program selection

– Programs and menus

Examples of configurable Startup settings are 5250 sessions, 3270
sessions, remote program sessions, Java application or applets, and IBM
Network Station Browser sessions.

 – Environment variables

Environment variable settings are also configured under Startup.
Environment variables can be used with Startup programs, menus, or any
applications that are running on the IBM Network Station.

 � Desktop Management

Examples of configurable Desktop settings are screen colors for window
frames, Icon placement, Font selection, and specifying how windows on the
Network Station are made active.

� 3270 Session configuration

Examples of configurable settings for 3270 sessions are screen size, key
remapping capability, color customization, and 3270 sessions with graphics
support.

� 5250 Session configuration

Examples of configurable settings for 5250 sessions are screen size, key
remapping capability, color customization (basic and advanced),
record/playback, and edit/copy/paste functions.

 � Internet configuration

 – Network

Examples of configurable Network settings are E-Mail address, default
home page, proxy settings, and encrypted or non-encrypted version of the
IBM Network Station Browser.

 – IBM Browser

Examples of configurable IBM Browser settings are disk caching, auto
loading of images, print headers and footers, and print margins.

– Navio NC Browser

Examples of configurable Navio NC Browser settings are caching, auto
loading of images, and network buffer size.

– Java Applet Viewer
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Examples of configurable Java applet viewer settings are message style,
heap and stack size settings, and defining properties.

This application also allows you to view the error messages generated by the
Network Station Manager program. This facility is limited to the Network Station
Manager administrator only.

This chapter discusses the following IBM Network Station Manager program topics:

� IBM Network Station Manager program overview

– Who can use the IBM Network Station Manager program

– Working with IBM Network Station Manager defaults

– Working with settings

� Starting the IBM Network Station Manager program. This section discusses:

– Starting the IBM Network Station Manager program from a web browser

– Signing onto the IBM Network Station Manager program

� Working with the IBM Network Station Manager program - Examples

� Viewing Network Station Manager Error Messages

IBM Network Station Manager Program - an Overview
Figure 4 on page 9 provides a graphical view of how the IBM Network Station
Manager program flows. Take a moment to study Figure 4 on page 9; it highlights
the differences between the defaults and setup tasks that a system administrator
and end user can work with.
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Figure 4. IBM Network Station Manager Program Flow

Who can use the IBM Network Station Manager Program?
As shown in Figure 4, both system administrators and individual end users can
access and use the program.

 System Administrators
System administrators are users having root authority and can work at a level that
is either system-wide or specifically for one user or one Network Station. For
example, an administrator could specify that all IBM Network Station users will have
one 3270 emulation session available and that one particular user could have an
additional 3270 emulation session.

For information on how to sign on to the IBM Network Station Manager program,
see “Starting the IBM Network Station Manager Program using a Browser” on
page 14.

Figure 5 on page 10 shows the screen a system administrator sees
 after signing onto the IBM Network Station Manager program. Notice the
 range of functions presented in the Setup Tasks frame.

Note:  This screen can vary in how it appears depending on the web browser you
are using.
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Figure 5. System Administrator Level

Compare these functions to the range of functions that are available to individual
end users as shown in Figure 6 on page 11.

Individual End Users
End users also have access to the IBM Network Station Manager program.
However, the functions that an end user can work with are limited to settings that
pertain only to themselves.

The following diagram shows the screen that an end user would see after signing
onto the IBM Network Station Manager program. Notice the range of functions
presented in the Setup Tasks frame.
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Figure 6. End-user Level

As you can see, the program's flexibility allows broad system-wide settings
management by the administrator and individual settings management by the end
user.

Working with IBM Network Station Manager Program Defaults
There are three levels of defaults. They are:

 � IBM-supplied defaults

IBM-supplied defaults are provided for all settings that are supported by the
IBM Network Station Manager program.

The IBM-supplied defaults cannot be changed. They can be overridden by
using the IBM Network Station Manager program feature of System defaults or
User level defaults.

 � System defaults

System defaults are used to change settings for all users or all Network
Stations.

System defaults take precedence over IBM-supplied defaults.

 � User defaults

User defaults are used to change settings for an individual user or individual
Network Station.

User defaults take precedence over IBM-supplied defaults and system defaults.

Note:  Settings work differently in the Startup function of Setup Tasks. For
Programs, Menus, and Environment Variables, the IBM-supplied,
System-specified, and User-specified, are additive. However, for the same
environment variable, the value set at the user level takes precedence over
the value set at the system or IBM-supplied levels. (That is, the values for a
given environment variable are not additive.) Any settings that are specified
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at the system or user level are added to those that are specified in the
IBM-supplied default settings.

IBM Network Station Manager Program Defaults - Example
This example uses the Desktop background setting that is in the Hardware function
of Setup Tasks.

The IBM-supplied setting for Desktop background is the IBM bitmap.

At this point, the administrator determines that all Desktop backgrounds will be set
to dark red. Using the IBM Network Station Manager program, the administrator
applies the change by working through the System Defaults level. This change, to
the color dark red, overrides the IBM-supplied value of the IBM bitmap for Desktop
background.

After viewing the new desktop background color of dark red, a user determines it is
too difficult to look at for long periods of time and requests his Desktop background
color be changed to green. The user can either change the Desktop background
color or request the administrator to do it.

The administrator can make the change by selecting the Hardware Setup Task,
User defaults and specify the user name of the person who is requesting the
change. Scroll to the Desktop background field and specify green. Click Finish to
apply the change. This change, to a User default setting, overrides the
IBM-supplied default and the administrator-set System Default value of dark red.

Notes:

1. If the user changed the Desktop setting, they would go directly to the Hardware
settings panel, bypassing the Default selection panel.

2. To view this change in Desktop settings you would have to log off and then log
on to the Network Station.

Working with System-Wide Defaults
Figure 7 on page 13 is representative of the panel that appears when a selection
is made from the Setup Tasks frame. In this example, the Hardware Defaults panel
is used.
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Figure 7. Hardware Defaults

As you can see, the Hardware Defaults panel allows you to work with System
defaults for all Network Stations and users, Network Station defaults for a particular
Network Station, or User defaults for a particular user. The Hardware Defaults
panel is unique in that it allows you to specify settings for Network Stations in
addition to specific users. If you want to specify defaults for a particular user, you
can click the Browse button and get a list of users on the system.

System defaults have settings that are not available when working with an
individual user or Network Station.

Working with Individual User Defaults
User defaults are designed to change settings on a user-by-user basis, one user at
a time. This gives you flexibility in custom tailoring individual sessions.

From any of the Default panels, select User defaults, enter the user name and
press the Next button.

Working with Settings
Settings are fields that you see after you have selected which defaults (System or
User) you want to work with. For example, Figure 8 on page 14 shows the
Desktop Manager Settings fields for Screen colors, Icon preferences, Fonts, and
Window focus.
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Figure 8. Desktop Manager Settings Fields

In this example, Figure 8 represents Desktop settings that are being worked with
from the System Defaults level. That means that any changes to the settings would
be applied to ALL  users.

Note:  Settings in the Startup function of Setup Tasks work differently than the
settings in other Setup Tasks. The difference is that any changes that are
made at the system default level and user default level are added to the
settings that are shipped with the IBM-supplied default settings.

For example, the IBM-supplied default is that all users have one 5250
session. Then, in Setup Tasks, the administrator selects Startup, Menus,
System defaults, 5250 and applies this setting. The result is that all users
would now have two 5250 sessions available to them.

Starting the IBM Network Station Manager Program using a Browser
To best understand and learn how the IBM Network Station Manager program
works, we recommend that you now sign on and follow the examples in this
chapter.

To start working with the IBM Network Station Manager program, power-on your
IBM Network Station, login, and click IBM Browser  from the Menu bar on your IBM
Network Station as shown in Figure 9.

Hide 3270

Figure 9. IBM Network Station Menu Bar

Note:  If you do not have, or have not installed, the IBM Network Station Browser
licensed program, you can use the following web browsers to sign on to the
IBM Network Station Manager program:
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� Navio NC Navigator

 � Netscape** 3.01

� Microsoft Internet Explorer** 3.01

The IBM Network Station Browser appears as shown in Figure 10:

Figure 10. IBM Network Station Browser Sign on Screen

Click the Edit pulldown and select IBM Network Station Manager Preferences as
shown in Figure 11 on page 16:
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Figure 11. IBM Network Station Browser Sign on Screen with Edit Pulldown

The IBM Network Station Manager program sign-on screen appears:

Figure 12. Sign on Screen

Note:  An alternative way to reach the IBM Network Station Manager program
sign-on screen is to enter the following case-sensitive URL in the IBM
Browser's URL field:

http://yourservername:portnumber/NetworkStation/Admin

where:

� yourservername  is the host name or TCP/IP address.

� portnumber  is the port that is configured for use with the IBM Network
Station program.
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If you have not changed the default port number for the ICS Webserver
(80), you do not need to specify portnumber.

Type your username and password, then click Ok

The Main Screen of the IBM Network Station Manager appears:

Figure 13. System Administrator Level

Working with the IBM Network Station Manager Program Setup Tasks -
Examples

Note:  You must be a system administrator to work with these examples.

As shown in Figure 13, setup tasks are represented by icons in the left-most frame
of the screen.

Clicking on any icon presents a panel where you select which set of Defaults you
want to work with.

When working with these examples, select User defaults and use your own user
name. Then, when you are done going through the examples, you will be able to
see the results on your Network Station.

In order to see the changes you make using the IBM Network Station Manager
program, you will have to log off and then log on to your Network Station. Do not
do this until we have gone through all of the examples that are presented here.
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Notes:

1. When going through the examples, the Main panel and the Default selection
panel will not be presented in this document every time.

2. See “Additional IBM Network Station Manager Program Examples” on page 25
for information on working with remote programs such as AIX sessions and
WinCenter Pro for PC applications.

Hardware Settings - User Example
From the Setup Tasks frame, click Hardware.

Select User defaults, and type in your user name (user001 in this example) as
shown in Figure 14.

Figure 14. Hardware Defaults Panel with User Defaults Specified

In the bottom frame, click Next to continue.

The Hardware Settings frame appears as shown (scrolled-down) in Figure 15 on
page 19.
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Figure 15. Hardware Settings User Example

Scroll to Desktop background and select the Tiles bitmap.

Click Finish to apply the change. Go to the next example.

Startup Settings Example
From the Setup Tasks frame, click Startup, click Programs, and select User
defaults. In the bottom frame, click Next to continue.

The Programs Settings frame appears as shown in Figure 16 on page 20.
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Figure 16. Startup Settings Example

Scroll to 3270 Sessions to Autostart. This setting, when completed, will
automatically start a 3270 session for you when you sign on to your Network
Station. Complete the following fields:

� S/390 system - Type the name or TCP/IP address of the S/390 your 3270
session will be established with.

� Session title - Type in a text string that represents your 3270 session. For
example, 3270#2. This text string will appear in the Title bar of your 3270
session. This field is optional and you do not need a value. However, in this
example you might want to try a name (3270#2) so you can see it when we
verify the examples.

� For the other settings fields, use the defaults.

Click Finish to apply the change. Go to the next example.

Desktop Manager Example
From the Setup Tasks frame, click Desktop Manager and select User defaults. In
the bottom frame, click Next to continue.

The Desktop Manager Settings frame appears as shown in Figure 17 on page 21.
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Figure 17. Desktop Manager Settings Example

Scroll to Icon preferences. In the Icon location field, select Top left.

Click Finish to apply the change. Go to the next example.

 5250 Example
From the Setup Tasks frame, click 5250 and select User defaults. In the bottom
frame, click Next to continue.

The 5250 Settings appear as shown in Figure 18 on page 22.

  Chapter 3. Using the IBM Network Station Manager Program 21



  
 

Figure 18. 5250 Setting Example

Scroll to the Allow use of the edit menu field and select No to disable the edit
menu. (The default is Yes, meaning that you can use the edit menu).

By disabling Allow use of the edit menu, your 5250 sessions will not have the Edit
pulldown displayed for use.

Click Finish to apply the change. Go to the next example.

 3270 Example
From the Setup Tasks frame, click 3270 and select User defaults. In the bottom
frame, click Next to continue.

The 3270 Settings panel appears as shown in Figure 19 on page 23.
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Figure 19. 3270 Settings Example

Scroll to the Screen size field. Select 24 x 80.

This will change your 3270 session screen size from 32 x 80 (the default) to 24 x
80.

Click Finish to apply the change. Go to the next example.

 Internet

Changing the IBM Network Station Default Port Number
The default ICS Webserver number is port 80. This port number is also the default
port number used by the IBM Network Station browsers to access the IBM Network
Station Manager program. If the ICS Webserver configured for use with IBM
Network Station Manager program does not use the default port 80, do the
following steps to configure the IBM Network Station browsers to select the
appropriate port.

1. Invoke the IBM Network Station Manager program

 http://yourservername:portnumber/NetworkStation/Admin

where:

� yourservername is the host name or TCP/IP address of the ICS Webserver

� portnumber is the port that is configured for use with the IBM Network
Station Manager program

If you have not changed the default port number for the ICS Webserver (80),
you do not need to specify portnumber

Enter the URL and log as a system administrator.
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2. Access the Internet Network System default panel. The Internet Network
System panel appears as shown in Figure 20 on page 24.

From the 'Setup Tasks' frame on the left, click Internet, click Network, and
select System defaults. In the bottom frame, click Next to continue.

3. Update the port number.

Scroll to the 'Proxy Section'. At the end of this section, see the following:

Web server port on the boot host:

To the right is a box that indicates 'Use default' or key in the new port number.

Enter the new port number (for example 8080).

Select Finish.

Figure 20. IBM Network Station Manager program Internet Network System Defaults

Reboot the IBM Network Station. Do the following to verify the change.

 1. Select Edit

2. Select Network Station Manager Program Preferences.

The updated port number appears in the URL.

Changing Other Internet Settings
From the Setup Tasks frame on the left , click Internet, click Network, and select
System defaults. In the bottom frame, click Next to continue.

The IBM Network Station Browser Settings frame appears as shown in Figure 21
on page 25.
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Figure 21. IBM Network Station Browser Settings Example

Scroll to the Proxy Section heading and select No in the Auto load images field.

Note:  Remember that if you apply this change, no images will display when you
are using a browser. After a page loads the text, you can use the browser's
Navigate pulldown menu to load the images. Select the Navigate pulldown,
and then select Load Missing Images.

Click Finish to apply the change. Click Main Screen in the Setup Tasks frame.

Verifying your Setting Changes
After completing the examples, you can verify the settings you specified.You will
need to log off and then log on for the settings to be applied.

Do not forget: :  If you do not want any of the settings specified in the example
exercises to remain, you will have to use the IBM Network Station Manager
program to return them to the original settings or some other settings of
your choice.

Additional IBM Network Station Manager Program Examples
Following is a list of additional examples that use the IBM Network Station Manager
program:

� Setting up an AIX session on your IBM Network Station by using Remote
Program support

� Setting up a Windows NT session on your IBM Network Station by using
Remote Program support
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Setting up an AIX Session using the IBM Network Station Manager
Program

Complete the following steps to setup an AIX session by using the IBM Network
Station Manager program:

1. Verify that the user name and password on the host system match the user
name and password on the AIX server.

2. You must create a .rhosts  file on the AIX server. This file must contain the
IBM Network Station's name and the name that the user logs into AIX with.
This file resides on the AIX server under the user's directory. An example for a
userid of user001:

Contents of File

Directory Structure: /home/userðð1

File name: .rhosts

IBM Network Station name MYNWS.mycompany.ABC.com

Name user signs on with: userðð1

This file can contain multiple lines. Each line should have one IBM Network
Station name and one user name on it. If a user will be working from more than
one IBM Network Station, create an entry for each IBM Network Station.

3. Sign on to the IBM Network Station Manager program.

4. From Setup Tasks, click Startup.

5. Under Startup, click Menu.

6. From Program Defaults, click User defaults.

If you are setting this up for someone else, type their user name or click
Browse to select their user name if you do not know it.

7. Click Next to continue.

8. Scroll ahead to Remote Programs. Type in the information as shown in
Figure 22.

Figure 22. Remote Program Example for AIX

Where:

Menu item label
This text string will appear in the Menu bar on the IBM Network Station.

Remote host
The name or IP address of the AIX server.
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Program to run
This identifies the program to run on the AIX server.

Optional parameters
-display is an AIX requirement that causes the program to display on the
IBM Network Station rather than on the remote host. ${IP} is an
IBM-supplied environment variable that gets replaced with the IP address of
the IBM Network Station. -lang C is an AIX requirement that is used by
programs such as Netscape on AIX.

The required parameters for AIX-Session are: -display and ${IP}:0.

9. Click Finish to apply the AIX remote program setting.

10. Log off and then log on your IBM Network Station. In the Menu bar there will
be a button that is labeled AIX-Session, as shown in Figure 23.

Show AIX-Session WinCenter Pro AIX-Session

Figure 23. Menu Button for Remote Program Example for AIX

11. Click AIX-Session and a window will open with your X-station session.

From the Aixterm window, you can run additional programs.

Setting up a Windows NT Session using the IBM Network Station
Manager Program

Complete the following steps to setup a Windows NT session by using the IBM
Network Station Manager program:

1. Verify that you have a Windows NT machine in your network that has the
WinCenter Pro** application loaded on it.

2. Verify that the user has a valid user name and password on the Windows NT
server. When the session from the Windows NT server is requested on the IBM
Network Station, the user will have to sign on.

3. Sign on to the IBM Network Station Manager program.

4. From Setup Tasks, click Startup.

5. Under Startup, click Menu.

6. From Program Defaults, click User defaults.

If you are setting this up for someone else, type their user name or click
Browse to select their user name if you do not know it.

7. Click Next to continue.

8. Scroll ahead to Remote Programs. Type in the information as shown in
Figure 24 on page 28.
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Figure 24. Remote Program Example for Windows NT

Where:

Menu item label
This text string will appear in the Menu bar on the IBM Network Station.

Remote host
The name or IP address of the Windows NT server.

Program to run
This identifies the program to run on the Windows NT server.

Optional parameters
-display is a WinCenter Pro requirement that causes the program to display
on the IBM Network Station rather than on the remote host. ${IP} is an
IBM-supplied environment variable that gets replaced with the IP address of
the IBM Network Station.

The required parameters for WinCenter Pro are: -display and ${IP}:0.

9. Click Finish to apply the WinCenter Pro remote program setting.

10. Log off and then log on your IBM Network Station. In the Menu bar there will
be a button that is labeled WinCenter Pro, as shown in Figure 25.

Show AIX-Session WinCenter Pro AIX-Session

Figure 25. Menu Button for Remote Program Example for NT - EDBAR

11. Click WinCenter Pro and a window will open with your WinCenter session.
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Chapter 4. Running Applications on Network Station in the
CDE/XDM Environment

Local clients (or local commands) are X programs that run on your own IBM
Network Station's processor, not on the RS/6000 server.

Available Local Clients
The following table lists the local clients currently available on IBM Network Station
for AIX, and the corresponding command name to use when running the command
from a remote shell, starting the client at boot time, or integrating the CDE desktop
to start the local client. (See “Starting Local Clients and Utilities” on page 30 for
instructions.)

Table 1. Local Client Commands

Local Client Command

Window Manager wm

Telnet term -ctype telnet [host]

5250 terminal emulator ns5250 [-port portnumber]
[host]

3270 terminal emulator ns3270 [-port portnumber]
host

Java applications java -classpath path
java_application

Java applets appletviewer html

 Window manager
See “CDE login and local window manager” on page 55 for a description of the
IBM Network Station local window manager.

 Telnet
The Telnet client gives you VT100 terminal access to UNIX hosts.

5250 terminal emulation
The 5250 client provides access to an AS/400 system.

3270 terminal emulation
The 3270 client provides access to a System/390.

 Java applications
Java applications are portable, machine-independent programs that can be
downloaded from the Internet to run on your IBM Network Station. :0. See
Appendix B, “Running Java Applets and Applications under CDE/XDM
Environment” on page 59 for additional information about running Java
applications.

Additional information about Java is also available at these web sites:

� JavaSoft home page—http://www.javasoft.com
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� IBM Java home page—http://www.hursley.ibm.com/java

 Java applets
Java applets are small, reusable components that are imbedded within an HTML
file. Applets utilize a browser on the client system to provide windows and graphical
layout for the applet.

See Appendix B, “Running Java Applets and Applications under CDE/XDM
Environment” on page 59 for additional information about running Java applets.

Additional information about Java is also available at these web sites:

� JavaSoft home page—http://www.javasoft.com

� IBM Java home page—http://www.hursley.ibm.com/java

Available Local Utilities
The following table lists the local utilities currently available on IBM Network Station
for AIX, and the corresponding command name to use when running the utility from
a remote shell, starting the utility at boot time, or integrating the CDE desktop to
start the utility. (See “Starting Local Clients and Utilities” for instructions.)

Table 2. Local Utilities

Local Utility Command

Console console

Terminal Host Chooser term

Statistics stats

IBM Login (AS/400, MVS, NT) actlogin

Memory show memory

Version show version

Connections show connections

Logout logout

Starting Local Clients and Utilities
You can start the local clients and utilities available on your system by one or more
of these methods, depending on how your system administrator has configured
your IBM Network Station:

� by remote shell (rsh)
� at boot time
� from the CDE desktop

By remote shell (rsh)
You can start local clients and utilities by using local client command names in
remote shell commands. Remote shell command syntax is:

rsh hostname command

where hostname is the IBM Network Station where the local client is to run and
command is the local client command.
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At boot time
Your system administrator can set the exec-startup-command  so that when you
boot your IBM Network Station, some or all locally available clients and utilities are
automatically started.

From the CDE desktop
Your CDE desktop can be configured to open a local client when you select its icon
from the Application Manager  window. See Appendix A, “Advanced CDE/XDM
Session Configuration” on page 55 for instructions.
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Chapter 5. Running Applications on Network Station in the
Common Login Environment

In the Common Login Environment, applications are started by selecting buttons on
the menu bar. By default, there are five buttons for applications to start with. They
are 5250, 3270, NSterm, IBM Browser, and Navio Browser. Before you use any of
these applications, please make sure that it is installed on the server that your
Network Station is booted from. If it is not, clicking on the button will have no effect.

Working with the NSterm Application
The NSterm application provides access to RS/6000 via telnet sessions. NSterm
basically is a VT320-style terminal emulator that allows Network Station users to
logon to any RS/6000 remotely. After you click the NSterm  button within the IBM
Network Station menu bar, a new NSterm Host Chooser window appears and
prompts for “Service:” Enter the host name of the RS/6000 that you intended to
access, making sure that the “Net:” field has “Telnet” specified.

Note:  You can use the name of the system or the IP address of the system to log
on. To use a system name, you must set up name translation information in
your TCP/IP configuration.

Depending on the volume of network traffic, you can expect it to take from several
seconds up to a minute to see the Host Login Session screen appear.

Click the OK button to invoke the telnet session. When the telnet session is
established, the NSterm Host Chooser disappears, the terminal emulator window
appears, and a host login prompt appears.

Working with the 3270 Application
The 3270 application provides access to a System/390. How a 3270 session is
presented on the IBM Network Station depends on how you configured the session
using the IBM Network Station Manager program.

If you used the Menu feature of the Startup function (within the IBM Network
Station Manager program) and you added a New 3270 session labeled MY3270,
that Menu button (labeled MY3270) will appear within the menu bar as shown in
Figure 26.

Hide 3270

Figure 26. IBM Network Station Menu Bar with NEW3270 Button

If the 3270 session was set to autostart, a 3270 session will appear on the screen
of your IBM Network Station as shown in Figure 27 on page 34.
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Figure 27. 3270 Session Display

If autostart was not specified and you click the 3270 button within the IBM Network
Station menu bar, a New 3270 Session window appears as shown in Figure 28.

Figure 28. New 3270 Session Dialog Box

Note:  You can use the name of the system or the IP address of the system to log
on. To use a system name, you must set up name translation information in
your TCP/IP configuration.

Depending on the volume of network traffic, you can expect it to take from several
seconds up to a minute to see the Host Login Session screen appear.
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Learning About the 3270 Emulation Function
3270 emulation provides system users with greater function than they normally
receive if they just use a 3270 nonprogrammable work station (NWS) to access a
System/390. This additional function is available by clicking various pulldown
options from the 3270 menu bar as shown in Figure 29:

New 3270 Session
Exit 3270

Online Help
for 3270 Topics

Fonts
APL2
Bracket

Auto Action
Block Cursor

Keypad

Keyboard Remapping

Figure 29. 3270 Emulation Session with Expanded Pulldowns

As shown in Figure 29, pulldowns are available to allow you to quickly access 3270
emulation functions such as font selection by session (Option pulldown) and online
help (Help).

The following list contains some of the 3270 emulation support:

 � Keyboard remapping1

 � Graphics support1

� Choosing an Enter key location1

� Screen size support (for example: 24 x 80, 32 x 80, 43 x 80, and 27 x 132)1

� APL character mode support
� Pop-up keypad support1

� Copy and paste functions
 � Auto action1

� Cursor style options (for example: underscore, block)
� Customizable window title1

All the 3270 emulation functions have shipped defaults. Those functions that are
managed by the IBM Network Station Manager program also have IBM-supplied
defaults.

1  The IBM Network Station Manager program controls these 3270 emulation functions. The online help in the IBM Network Station
Manager program provides more information along with all 3270 emulation default settings.
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Accessing the 3270 emulation Help (clicking the Help button) will provide more
information on how to make each of these 3270 emulation functions work.

 Accessing Help
You can access help for the 3270 Emulator or your Host session.

For the 3270 emulator, place your mouse pointer in the emulator's menu bar and
click Help. In general, to access help for the 3270 application, place your mouse
pointer inside the Host session window and press F1.

Working with the 5250 Emulation Application
The 5250 application provides access to a host system. How each 5250 session is
presented on the IBM Network Station depends on how you configured the session
using the IBM Network Station Manager program.

If you used the Menu feature of the Startup function (within the IBM Network
Station Manager program) and you added a new 5250 session labeled MY5250,
that menu button (labeled MY5250) will appear within the menu bar as shown in
Figure 30.

Hide MY5250

Figure 30. Menu Bar with New 5250 Button - menu5250

If, in the IBM Network Station Manager program, the 5250 session was set to
autostart, a 5250 session will appear running on the screen of your IBM Network
Station as shown in Figure 31.

Figure 31. 5250 Session Display

If you click the 5250 button within the IBM Network Station menu bar, a New 5250
Session window appears as shown in Figure 32 on page 37.
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Figure 32. New 5250 Session Dialog Box

Note:  You can use the name of the system or the IP address of the system to
connect to or start a session. To use a system name, you must set up
name translation information in your TCP/IP configuration.

Depending on the volume of network traffic, you can expect it to take from several
seconds up to a minute to see the host sign-on display appear.

Learning About the 5250 Emulation Function
5250 emulation provides system users with greater function than they normally
receive if they just use a nonprogrammable work station (NWS) to access the
system. This additional function is available by clicking various pulldown options
from the 5250 menu bar as shown in Figure 33:

Figure 33. 5250 Emulation Session with Expanded Pulldowns

As shown in Figure 33, pulldowns are available to allow you to quickly access 5250
emulation functions such as multi-session support (Command pulldown), font
selection by session (Option pulldown), and online help (Help).

The following list contains additional 5250 emulation support:
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 � Keyboard remapping2

� Color mapping (basic and advanced)2

 � Record/playback capability2

� Autostart of playback file (from the Record/playback function)2

 � Auto-logon
� Enter key location (you can specify your choice of key to be used for the Enter

key)
� Multiple screen size support (for example: 24 X 80, 27 X 132)
� OV/400 controller text assist
� Cut, copy, paste function2

 � Hotspot support
� Cursor style options (for example, block or underscore)
� Rule line support
� Row and column indicator
� Customizable window title2

� Column separator function

All the 5250 emulation functions have shipped defaults. Those functions that are
managed by the IBM Network Station Manager program also have IBM-supplied
defaults.

Accessing the online 5250 Emulation Help (by clicking the Help button) will provide
more information on how to make each of these 5250 Emulation functions work.

 Accessing Help
You can access help for the 5250 Emulator or your host session.

For the 5250 emulator, place your mouse pointer in the emulator's Menu bar and
click Help. To access help for RS/6000, sign on to the RS/6000, place your mouse
pointer in the host session window and press F1.

Working with the IBM Browser
The IBM Browser can provide access to the Internet. It is also used to access the
IBM Network Station Manager program, which is used to manage IBM Network
Station users and workstations.

If you used the Menu feature of the Startup function (within the IBM Network
Station Manager program) and you added a new IBM Network Station Browser
session labeled IBM Browser, that Menu button (labeled IBM Browser) will appear
within the menu bar as shown in Figure 34.

Hide 3270

Figure 34. IBM Network Station Menu Bar with IBM Browser Button

2  The IBM Network Station Manager program controls these 5250 Emulation functions. The online help in the IBM Network Station
Manager program provides more information along with all 5250 emulation default settings.
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If the IBM Browser session was set to autostart, an IBM Browser session will
appear on the screen of your IBM Network Station as shown in Figure 35 on
page 39.

Figure 35. IBM Browser Session Display

If autostart was not specified, and you click the IBM Browser button within the
menu bar, an instance of the IBM Browser appears.

Depending on the volume of network traffic, you can expect it to take from several
seconds up to a minute to see the new IBM Browser screen appear.

IBM Browser News - What is the Latest?
To find out the latest information about IBM Browser features and what is new with
this level of the IBM Browser product, click Help on the IBM Browser main page.

Select the HELP Page option from the Help pulldown.

In the Contents frame, scroll to Frequently Asked Questions (FAQ) or the README
items. Either of these items provide late-breaking information about the IBM
Browser.

IBM Browser Capabilities
Key IBM Browser features that are available in the first release of the browser
include the following:

� Ability to display Web pages that contain text, HTML, GIF images (including
animated GIFs), and JPEG images

� Javascript 1.1 or compatible

 � HTML 3.2
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 � Frames

� SSL 2 at 128 or 40 bit levels (in separate versions of the product, for US and
Canada, or for export, respectively)

� Java applets can be run by the IBM Network Station Java VM

IBM Browser MIME Types:
Table 3. IBM Browser MIME Types

TYPE/SUBTYPE USAGE

Text/plain Plain text with no HTML tags

Text/HTML Text with HTML markup tags

Image/gif GIF images, including animated GIFs

Image/jpeg JPEG images

Note:  No other MIME types are supported (because they require plug-ins or helper
applications).

IBM Browser URL Types Supported
The IBM Browser can handle the following URL types:

Table 4. IBM Browser URL Types Supported

URL TYPE USAGE

HTTP Display content using HTTP protocol,
such as any web page with HTML, and
so forth

HTTPS Same as HTTP, but using SSL security

MAILTO Start the e-mail editor to create and send
an e-mail message

ABOUT Display copyright information about the
browser

FTP Open an FTP session

JAVASCRIPT Run JavaScript

VIEW SOURCE Display source file

Learning About IBM Network Station Browser Functions
The IBM Network Station Browser licensed program has many capabilities to help
you manage Internet access and quick connection the IBM Network Station
Manager program.

These functions, and others, are available by clicking various pulldown options from
the IBM Browser menu bar as shown in Figure 36 on page 41 :
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Figure 36. IBM Network Station Browser with Extended Pulldowns

As shown in Figure 36, pulldowns are available to allow you to quickly access IBM
Browser functions such as multiple IBM Browser session support (New Window in
the File pulldown), font selection by user (User Preferences in the Edit pulldown),
and online help (Help).

The following list contains some of the IBM Network Station Browser support:

� Open URL. . .

� Open Local. . .

Opens an ASCII or HTML file.

 � Close

� Save As. . .

Saves a file with user-specified name and file extension.

 � Print3

� View Source. . .

Views the program source for the file in the current IBM Browser session.

 � User Preferences3

3  The IBM Network Station Manager program controls these IBM Browser functions. The online help in the IBM Network Station
Manager program provides more information along with all IBM Browser default settings.
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Allows configuration of fonts, colors, printing, caching and so on.

� IBM Network Station Manager program preferences. . .

Provides a direct link to the IBM Network Station Manager program.

� History. . .

Provides a list of web pages that were visited during the current IBM Browser
session.

 � Hotlist

A list of frequently visited web pages. Access the web page by clicking the
Hotlist entry.

 � Tile

Tile allows you to manage how multiple IBM Browser sessions will be
presented on the display screen. For example, assume that you want four
sessions. You can use the Tile function to specify two side-by-side sessions at
the top of the display followed by two side-by-side sessions at the bottom of the
display.

 � Cascade

Cascade allows you to manage multiple IBM Browser sessions on the display
screen by layering one over the other. Each new session is slightly lower that
the previous session, thus allowing a user to work with all active IBM Browser
sessions.

 � Help Page

Allows a user to access Help for the IBM Browser through a Contents listing on
this page. Key topics are the README and the Frequently Asked Questions
(FAQ).

 � Support Information

Allows a user to view and save IBM Browser support information to a file.

Many of the IBM Browser functions have shipped defaults. Those functions that are
managed by the IBM Network Station Manager program also have IBM-supplied
defaults.

 Accessing Help
You can access help for the IBM Browser via the Help menu option. The help
includes a Frequently Asked Questions (FAQ) section, and an addendum for
last-minute changes.

For IBM Browser help, place your mouse pointer in the IBM Browser Menu bar and
click Help.

Changing the IBM Browser Encryption Level for Improved Transaction
Security

To change the IBM Browser encryption capability, use the IBM Network Station
Manager program. You will need to work with the Internet Setup Task and select
Network.
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Working with the Navio NC Navigator Browser
Navio NC Navigator Browser can provide access to the Internet. It is also used to
access the IBM Network Station Manager program, which is used to manage IBM
Network Station users and workstations.

If you used the Menu feature of the Startup function (within the IBM Network
Station Manager program) and you added a new Navio NC Navigator Browser
session labeled Navio Browser, that Menu button (labeled Navio Browser) will
appear within the Menu bar as shown in Figure 37.

Hide Navio Browser3270

Figure 37. IBM Network Station Menu Bar with Navio Button

If the Navio NC Navigator browser session was set to autostart, an Navio NC
Navigator browser session will appear on the screen of your IBM Network Station
as shown in Figure 38.

Figure 38. Navio NC Navigator Browser Session Display

If autostart was not specified, and you click the Navio button within the Menu bar,
an instance of the Navio NC Navigator browser appears.

Depending on the volume of network traffic, you can expect it to take from several
seconds up to a minute to see the new Navio NC Navigator browser screen
appear.

Navio NC Navigator Browser News - What is the Latest?
To find out the latest information about Navio NC Navigator browser features and
what is new with this level of the Navio NC Navigator browser product, click Help
on the Navio NC Navigator main page.

Select the HELP for Navio NC Navigator option from the Help pulldown.
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In the Contents frame, scroll to Frequently Asked Questions (FAQ) or the README
items. Either of these items provide late-breaking information about the Navio NC
Navigator browser.

Navio NC Navigator Browser Capabilities
In general, Navio NC Navigator is a compatible subset of the popular Netscape
Navigator 3.01 browser (UNIX version). Key features that are available include the
following:

� Ability to display Web pages that contain text, HTML, GIF images (including
animated GIFs), and JPEG images

 � Javascript 3

� HTML Compatible with Navigator 3.01

 � Frames

� SSL 2 and 3 at 128 or 40 bit levels (in separate versions of the product, for US
and Canada, or for export, respectively) with server and client certificates

� Java applets can be run by the IBM Network Station Java VM

Navio NC Navigator MIME Types:
Table 5. Navio NC Navigator MIME Types

TYPE/SUBTYPE USAGE

Text/plain Plain text with no HTML tags

Text/HTML Text with HTML markup tags

Image/gif GIF images, including animated GIFs

Image/jpeg JPEG images

Note:  No other MIME types are supported (because they require plug-ins or helper
applications).

Navio NC Navigator URL Types Supported
The Navio NC Navigator Browser can handle the following URL types:

Table 6. Navio NC Navigator URL Types Supported

URL TYPE USAGE

HTTP Display content using HTTP protocol,
such as any web page with HTML, and
so forth

HTTPS Same as HTTP, but using SSL security

MAILTO Start the e-mail editor to create and send
an e-mail message

ABOUT Display copyright information about the
browser

FTP Open an FTP session

JAVASCRIPT Run JavaScript

VIEW SOURCE Display source file
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Learning About Navio NC Navigator Browser Functions
The Navio NC Navigator browser licensed program has many capabilities to help
you manage Internet access and quick connection to the IBM Network Station
Manager program.

These functions, and others, are available by clicking various pulldown options from
the Navio NC Navigator browser Menu bar as shown in Figure 39:

New Window
Open URL...
Open Local...
Close
Save As...
Print
Exit

Cut
Copy
Paste

Find...

View Source...
User Preferences...
IBM Network Station

Manager
Preferences...

Select All

Find Again

Back
Forward
Home
History...
Hotlist...
Add current to Hotlist

Reload
Load missing Images

NSB Help Page
Support Information
About NSB

Tile
Cascade
IBM Network
Station Help

Figure 39. Navio NC Navigator Browser with Extended Pulldowns

As shown in Figure 37 on page 43, pulldowns are available to allow you to quickly
access Navio NC Navigator functions such as multiple Navio NC Navigator browser
session support (New Web Browser in the File pulldown), font selection by user
(General Preferences in the Option pulldown), and online help (Help).

The following information presents and describes some of the Navio NC Navigator
browser support.

 File Pulldown
The following Navio NC Navigator functions are available from the File pulldown:

New Web Browser
Provides another session of the Navio NC Navigator browser to appear on your
screen.

New Mail Message
Provides the capability to address and send E-mail to another person. To use
New Mail Message, you must have the Identity tab, located in the Options
pulldown under Mail & News Preferences, completed.

  Chapter 5. Running Applications on Network Station in the Common Login Environment 45



  
 

Mail Document
Provides the capability to address and send documents to another person. To
use Mail Document, you must have the Identity tab, located in the Options
pulldown under Mail & News Preferences, completed.

Open Location
Provides the capability to specify a URL address that, when requested, is
displayed in the browser window.

Open File
Provides the capability to specify a file that, when requested, is displayed in the
browser window.

Save as. . .
Provides the capability to save (with a different name and file type) a document
or file currently displayed in the browser.

Print
Provides the capability to specify how (paper size, print orientation, font, which
pages, and so on) a document currently displayed in the browser will be
printed.

Close
Provides the capability to close the current browser window. Any other browser
windows remain open.

Exit
Provides the capability to close all browser sessions at once.

 Edit Pulldown
The following Navio NC Navigator functions are available from the Edit pulldown:

Undo
Provides the capability to undo or cancel the previous operation. For example,
if you deleted a word and decided you did not want to, you could click undo
and the word would return.

Cut
Provides the capability to delete specified pieces of a document.

Copy
Provides the capability to copy specified pieces of a document so that it can be
pasted elsewhere.

Paste
Provides the capability to paste (or insert) specified pieces of a document that
had been marked for either copying or cutting (deleting).

Find
Provides the capability to search a document for a specified word or text string.

Find Again
Provides the capability to search a document for multiple occurrences of a word
or text string.
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 View Pulldown
The following Navio NC Navigator functions are available from the View pulldown:

Reload
Provides the capability to reload (retrieve) the currently displayed page. You
also have a Reload button in the Tool bar.

Reload Frame
Provides the capability to reload the active frame of a document currently
displayed in the browser.

Load Images
Provides the capability to retrieve the images for the document currently
displayed in the browser. Load Images only works if the Auto Load Images
function (located in the Options pulldown) is off.

Refresh
Provides the capability to retrieve a new copy of the currently displayed
document. The new copy is retrieved from cache, not from a server.

Document Source
Provides the capability to view the HTML source of the currently displayed
document.

Document Info
Provides the capability to retrieve basic information about the currently
displayed document. For example, creation date, date last modified, size,
number of URL links on the page.

Frame Source
Provides the capability to view the HTML source for the active frame currently
displayed in the browser.

Frame Info
Provides the capability to retrieve basic information about the active frame
currently displayed in the browser. For example, creation date, date last
modified, size, number of URL links on the page.

 Go Pulldown
The following Navio NC Navigator functions are available from the Go pulldown:

Back
Provides the capability to navigate backwards to previously accessed
documents. Back is only active if you have been to one or more documents. A
Back button is also available on the Tool bar.

Forward
Provides the capability to navigate forward to previously visited documents.
Forward is only active if you have been to a document and then navigated (or
moved) backwards. A Forward button is also available on the Tool bar.

Stop
Provides the capability to stop or end the activity of loading a new document to
be displayed in the browser. A Stop button is also available on the Tool bar.

Remainder of Go Pulldown
Entries in the remainder of the Go pulldown represent URL locations that you
have been to in the current browser session. You can access these locations
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by clicking on them or by pressing the listed combination of keys (usually Alt +
a number).

 Bookmarks Pulldown
The following Navio NC Navigator functions are available from the Bookmarks
pulldown:

Add Bookmark
Provides the capability of adding the URL of the currently displayed document
to your list of bookmarks. Bookmarks is a list of URLs that a user frequently
visits. Placing the URL in the Bookmark list gives a user quick access to those
URLs.

Remainder of Bookmarks Pulldown
Entries in the remainder of the Bookmarks pulldown represent URL locations
that can be accessed by clicking them. To change or delete items that you
have added to this list, use the Bookmarks item on the Window pulldown.

 Options Pulldown
The following Navio NC Navigator functions are available from the Options
pulldown:

General Preferences...
Provides the capability to customize browser appearance, browser fonts, and
how images are handled by the browser.

Mail and News Preferences...
Mail and News Preferences consists of the following tabs:

 � Compose

Provides the capability to specify how E-mail is handled when it is mailed.

 � Servers

Provides the capability to view the name of the SMTP server.

 � Identity

Provides the capability of identifying yourself and your organization for the
purpose of using E-mail and the sending of documents.

Network Preferences
Network Preferences consists of the following tabs:

 � Cache

Provides the capability to clear memory caches and specify how often
cached documents are verified.

 � Connections

Provides the capability to specify the number of connections to an internet
server and to determine the size of the network buffer (amount of data
Navio NC Navigator can receive in a transmission).

 � Proxies

Provides the capability to view your proxy configurations. You have to work
with the network administrator to understand or change any proxy
configurations.
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 � Protocols

Provides the ability for you to be notified before accepting a cookie from a
remote server. A cookie is a mechanism that allows a server to remember
information about you that the server can use in subsequent sessions.

 � Languages

Provides the capability to view how Java and JavaScript are configured.
Java and JavaScript are controlled by the IBM Network Station Manager
program. Work with your system administrator if changes need to be made
to the configuration of Java or JavaScript.

Security Preferences
Security preferences consist of the following tabs:

 � General

Provides the capability to set an alert when entering, leaving, viewing, or
submitting a document insecurely. These alerts can also remind you of
when you change levels of security.

 � Passwords

Provides the capability to specify that a password be required from people
who want to access your computer.

 � Personal Certificates

Provides validation of who you say you are when attempting to access a
secure server. Personal certificates are password protected (from the
password tab). To obtain personal certificates you have to contact
companies that issue personal certificates. If a personal certificate is
issued, it is typically downloaded to your computer and accessible through
the browser. You can view or delete personal certificates. However, you
can not edit or modify personal certificates.

 � Site Certificates

Provides validation that this user, on this machine (the site), is who they
say they are while attempting to access a secure server. Site certificates
can be issued by secure servers. They are typically downloaded to your
computer and accessible through the browser. You can view or delete site
certificates. However, you can not edit or modify site certificates.

Show Menubar
Provides the capability to have the Menu bar displayed or not displayed during
a browser session. The Menu bar contains the File, Edit, View, Go, Bookmarks,
Options, Directory, Window, and Help pulldowns. If you deselect Show
Menubar, the Menu bar immediately disappears from the browser. To retrieve
the Menu bar, press the right mouse button and select Show Menubar.

Show Toolbar
Provides the capability to have the Toolbar displayed or not displayed during a
browser session. The Toolbar provides buttons for Back, Forward, Home,
Reload, Images, Open, Print, Find, and Stop buttons. If you deselect Show
Toolbar, the Toolbar immediately disappears from the browser. To retrieve the
Toolbar, select the Options pulldown and select Show Toolbar.
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Show Location
Provides the capability to enter a URL directly from the keyboard and show the
URL for the current document.

Show Directory Buttons
Provides the capability to display or not display directory buttons. Directory
buttons provide users with quick access to specified URLs. Directory buttons
are best used to provide access to certain URLs for all users. Directory buttons
are similar to Bookmarks; however, Bookmarks are generally used for personal
preference rather than for a whole organization. Directory buttons, when
specified, appear below the Location field in the browser. Directory buttons are
managed through the IBM Network Station Manager program. No Directory
buttons will be shown unless they have been defined by your installation.

Auto Load Images
Provides the capability to have images loaded automatically or not at all when
a document is requested. You may want to select this option if you are
browsing documents on remote servers. Auto Load Images works in
conjunction with the Load Images item in the View pulldown. If Auto Load
Images is disabled, images can be loaded for a particular document by using
the Load Images function under the View pulldown.

Save Options
Provides the capability to immediately save any changes made to any Options.

 Directory Pulldown
The following Navio NC Navigator functions are available from the Directory
pulldown:

Navio's Home
This Directory entry provides a link to Navio's home page.

You must be able to access the Internet to use this item.

IBM Network Computing
This Directory entry provides a link to IBM's Network Computing home page.

You must be able to access the Internet to use this item.

IBM Home Page
This Directory entry provides a link to IBM's corporate home page.

You must be able to access the Internet to use this item.

IBM Network Station Manager for (your system name appears here)
This Directory entry provides a link to the IBM Network Station Manager
program for the server system that your IBM Network Station was loaded from.
This program is used to manage all IBM Network Stations and their users.

 Window Pulldown
The following Navio NC Navigator functions are available from the Window
pulldown:

Address Book
Provides the capability to compile a book of names and addresses of
individuals or groups you correspond with on a regular basis. This item is used
for sending mail.
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Search, editing, and filing capabilities are also provided in the Address Book
function.

Bookmarks
Provides the capability to file, edit, and manage your personal lists of
bookmarks.

The Bookmark function activities you perform are reflected in the list of
bookmarks that you can view using the Bookmarks pulldown in the Tool bar.
For example, if you have two bookmarks whose names are very similar, you
could edit one of them and add a text string that more readily identifies the
bookmark when you access the Bookmarks pulldown.

History
Provides the capability to view a list of documents you have accessed during
this session.

From this list you can create bookmarks for documents previously accessed or
go directly to any selected document.

Remainder of Window Pulldown
The remainder of the Window pulldown contains a list of documents you have
accessed during this session. You can access the document by pressing the
push button next to it.

 Help Pulldown
The following Navio NC Navigator functions are available from the Help pulldown:

About Navio NC Navigator
Provides the version level and trademarking information about Navio NC
Navigator.

Help for Navio NC Navigator
Provides help information and Frequently Asked Questions (FAQs).

Navio NC Navigator Handbook
Provides additional information about using the browser.

Many of the Navio NC Navigator browser functions have shipped defaults. Those
functions that are managed by the IBM Network Station Manager program also
have IBM-supplied defaults.

 Accessing Help
You can access help for the Navio NC Navigator browser using the Help menu
option. The help includes a Frequently Asked Questions (FAQ) section, and an
addendum for last-minute changes.

For Navio NC Navigator browser help, place your mouse pointer in the Navio NC
Navigator browser Menu bar and click Help.
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 JAVA VM
You can set up Java applets and applications by using the IBM Network Station
Manager. The applets and applications can be set to either autostart (they appear
running on your Network Station when you login) or set as menu items (they
appear as buttons in the menu bar).

Note:  Only a single Java application can run within the IBM Network Station and,
if running, also precludes applets from running in both the desktop and in
the browser.

The Java Virtual Machine (JVM) and the supporting class packages that were
installed with the product together provide an environment for programs that were
written and compiled in the Java programming language. The current level of Java
that is supported by the IBM Network Station is equivalent to the 1.0.2 level
distribution of the Java Development Kit (JDK) from JavaSoft. You can start and
configure Java programs through the IBM Network Station Manager program.

What Is Java?
Java is an object-oriented programming language. Java is compiled into a byte
code stream which JVM interprets at runtime. Java programs are portable and, in
general, may be run on any computer that supports a JVM. This is one of the
primary attractions of the Java language.

What do I do with Java?
In order to use Java, you must first obtain a program that was written in Java. This
may be a program that you have purchased, downloaded from the Internet, or
written and compiled by yourself. In general, the IBM Network Station is not geared
towards being a development platform; therefore any significant program should be
developed on another platform before loading it on the IBM Network Station.

What are Java Applications and Applets?
There are two kinds of Java programs: those which are intended to be transferred
and run across the Internet (applets), and those which run as programs from the
local file system (applications). The first variety, applets, are designed so that they
utilize a browser to provide windows and graphical layout for the applet. In general,
these applets are not trusted by the browser since they are downloaded across the
Internet and there is no way of knowing the intent of the author. Therefore, the
browser has the ability to restrict applets from reading or writing to local files and
from connecting to machines other than the machine from which they are
downloaded. These restrictions are intended to protect the user from malicious
programs and provide a safe environment to examine programs on the Internet.

Starting an Application
An application must be installed on the file system of the server.
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Notes:

1. Only a single Java application can run within the IBM Network Station and, if
running, also precludes applets from running in both the desktop and in the
browser.

2. In order to run a Java application, the IBM Network Station Manager program
must be used to either autostart the application or create a button on the IBM
Network Station menu bar.

Starting an Applet
Applets can be installed on the file system of the server that is your boot host, or
downloaded from a remote system by using a Uniform Resource Locator (URL).
The applet to load is specified through tags on an HTML page.

Applets can be run three different ways:

� By creating a button on the IBM Network Station menu bar for an applet

� By creating a button for a browser URL

� By starting a browser then loading an HTML page which contains an applet

Configuration of the applet is managed through parameter tags within the HTML file
(the specific parameter names are determined by the applet vendor). Applets that
load from the file system of your boot host should be well-known and trusted
applets (the source of the applets is reliable). There are no security restrictions
placed on applets that run from the local file system, so the applet may write to files
and communicate with other machines (which may be desirable if you are saving
your spreadsheet, but it would be a problem if a malicious applet decided to erase
your files).

Where do I find Additional Information on Java?
You can find additional information at the following web sites.

JavaSoft home page:

 http://www.javasoft.com

IBM Java home page:

 http://www.ibm.com/java
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Appendix A. Advanced CDE/XDM Session Configuration

Basic Session Configuration

Common Desktop Environment (CDE)
The CDE Style Manager lets you customize the colors, fonts, backdrops, keyboard,
mouse, bell screen, window, startup, and workspace behavior of the desktop.

Extensive help is available for Style Manager. Select the Help  icon from the
toolbar, select Common Desktop Environment  from the Welcome to Help
Manager menu, then select Style Manager Help  from the Common Desktop
Environment menu.

X Display Manager (XDM) and Motif Windows Manager (MWM)
You can customize your Motif Window Manager desktop by using the custom tool,
and also creating a .xinitrc  and a .mwmrc  file in your home directory. See the
AIXWindows Desktop Advanced User's and System Administrator's Guide
(SC23-2671) for instructions.

Advanced Session Configuration

CDE login and local window manager
As previously discussed, the IBM Network Station also offers its own local window
manager client, based on Motif Window Manager, but simpler and less resource
intensive. If your system has been set up to start CDE as your environment, but
you'd prefer to use the IBM Network Station's local window manager client, add the
following to your $HOME/.Xdefaults  file:

#ifdef EXT_NCD_SETUP

Dtsession\wmStartupCommand: /usr/bin/rsh SERVERHOST wm

#endif

After adding the above line to your .Xdefaults  file, you'll have to log out of your
current session, then log back in for the change to take effect.

Note:  This type of session does not use the CDE Front Panel and doesn't allow
access to the normal CDE root window capabilities. The local window manager
root menu can be accessed by pressing the Shift and Alt keys on the keyboard and
the right mouse button.

When you're ready to log out, press the Pause/Break key to bring up the console
window, select the Login  menu, then select Logout from the Login pull-down
menu.

You can also log out from the root menu. Press the Shift and Alt keys on the
keyboard and the right mouse button, then select Logout  from the root menu.
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X Server preferences
As a user, you can set a number of preferences for your IBM Network Station
sessions by creating a $HOME/.netstationrc  file.

This is a typical entry in the .netstationrc  file:

set pref-mouse-arrangement = left-handed

To understand the meaning of a parameter listed in any of the configuration files in
/usr/netstation/configs , refer to the /usr/netstation/configs/configd.doc  file,
which contains descriptive information about each parameter.

Note:  Since the configd.doc  file contains entries for hundreds of parameters, a
useful way to find the one you need is to open the file in a text editor (for example,
vi), then search for the parameter you want to change.

This is the configd.doc  entry for the pref-mouse-arrangement parameter:

In this case, the user has configured the mouse to be set up for a left-handed user.

Note:  As a user, you can add an entry for a parameter only if its name in the
configd.doc  file begins with the string pref.

NAME pref-mouse-arrangement
HIDEBOX Console=>Setup=>Change User Preferences=> Pointing

Devices=>Button Arrangement
SNMP NAME ncdPrefMouseButtonArragement
SNMP PATH ncdPref 13
TYPE CHOICE
CHOICES { right-handed left-handed }
DEFAULT right-handed
PERMISSION READ-WRITE
EFFECT IMMEDIATE
NVRAM NO
DESCRIPTION Specifies whether the mouse buttons are mapped with

Button1 at the right or left.

 CDE Integration
Your CDE desktop can be configured to open a local client when you select its icon
from the Application Manager  window. You have two options to create a CDE
Action:

 � manually
� using the Create Action graphical interface

Creating a CDE Action manually
1. Using a text editor (for example, vi), create a file called networkstation.dt .

2. Create an entry in the networkstation.dt  file like the one in this example. The
CDE Action created here opens a telnet session when the user selects the
Telnet icon:
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ACTION NsTelnet

{

 TYPE COMMAND

 WINDOW_TYPE NO_STDIO

 ICON Dtterm

 LABEL Telnet

EXEC_STRING /bin/ksh -c " \

 H="%"Hostname:"%"; \

A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \

rsh \$A term -ctype telnet \$H"

DESCRIPTION Network Station telnet terminal emulator

}

3. Save the networkstation.dt  file in the $HOME/.dt/types  directory and close
the editor.

4. At the command line, type:

touch $HOME/.dt/appmanager/ACTION

where ACTION corresponds to the Action you're creating. In our example, this
is the command:

touch $HOME/.dt/appmanager/NsTelnet

5. At the command line, type:

chmod 755 ACTION

where ACTION corresponds to the Action you're creating. In our example, this
is the command:

chmod 755 NsTelnet

6. At the command line, type:

dtaction ReloadApps

The CDE Action has been created. If you want to confirm that the procedure
worked, select the Application Manager  icon from the Front Panel. You'll see the
icon labeled Telnet in the box that opens.

See Appendix D, “CDE Action” on page 65 for a listing of other CDE Actions.

Creating a CDE Action using the Create Action graphical interface
Note:  This procedure creates the same CDE Action as the one described above.

1. Select the Application Manager  icon (located on the Front Panel between the
Style Manager and the Help Viewer).

2. Select the Desktop_Apps  icon from within the Application Manager window.

3. Select the Create Action  icon from within the Desktop_Apps window.

4. In the Create Action window, enter this information:

Action Name (Icon Label): NsTelnet
Command When Action is Opened: /bin/ksh -c " H="%"Hostname:"%";

A=echo \$DISPLAY |awk -F':' '{print \$1}' ; rsh \$A term -ctype telnet \$H"

5. Select Find Set  to set the icon.

6. Type Dtterm in the Enter Icon Filename field.

7. Select the OK button.
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8. In the Create Actions window, Select Save from the File pull-down menu.

The CDE Action has been created. If you want to confirm that the procedure
worked, select the Application Manager  icon from the Front Panel. You'll see the
icon labeled NsTelnet in the box that opens.

Note:  The icon's label is different than the label created in the manual procedure;
the manual procedure offers the opportunity to label the icon something other than
the Action name; the GUI procedure does not offer that opportunity.

See Appendix D, “CDE Action” on page 65 for a listing of other CDE Actions.

For additional details on adding actions, please read the Create Action section of
Application Manager Help. Select the Application Manager icon on the CDE Front
Panel. Select Help  from the menu bar, then use the Search function to search for
entries with Create Action.
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Appendix B. Running Java Applets and Applications under
CDE/XDM Environment

Note:  In order for you to be able to run a Java applet or application on your IBM
Network Station, your system administrator must make a directory available on the
RS/6000 server for your applets and applications. The directory must be accessible
from the IBM Network Station by either TFTP or NFS. By default only one such
directory is accessible— /usr/netstation —but that directory is writable only by the
root user.

Running a Java applet
Note:  In the instructions below, $NS is the default directory for IBM Network
Station software, /usr/netstation , and $ACT is the hostname of the IBM Network
Station.

Applet setup
To run the Java applet Smooth  on the IBM Network Station, the
smooth.class  java class file must reside in a directory with its HTML
configuration file, and it must be readable by the client. For example:

$NS/applets/smooth/smooth.class

$NS/applets/smooth/Smooth.html

HTML setup
The Java Virtual Machine (JVM) must read the Java applet's
characteristics before the applet is loaded. An HTML file is created to
define the Java code and its window parameters. For example:

  <HTML>
  <HEAD>
   <TITLE> IBM Network Station</TITLE>
  </HEAD>
  <BODY>
  <CENTER>
   <APPLET CODE="smooth.class"
   NAME="Smooth"
   WIDTH=400
   HEIGHT=400>
   </APPLET>
  </CENTER>
  </BODY>
  </HTML>

Note:  The APPLET CODE names the path to the Java applet relative
to the HTML file.

Command
The JVM reads its Java classes and applet classes from the server via
TFTP or NFS. The JVM's classpath, when using the appletviewer, is
pre-set to find the JDK classes; the users needs only to specify the path
to the applet itself. In our example, type at the command line:

rsh $ACT appletviewer $NS/applets/smooth/Smooth.html
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Multiple applets
Only one instance of the JVM can be launched on the IBM Network
Station; however, the appletviewer of the JVM can run multiple applets
as threads. For example, to run the Rotator  and Scribble  applets, type
at the command line:

rsh $ACT appletviewer $NS/applets/Rotator/RotX.html

and press the Enter key, then type at the command line:

rsh $ACT appletviewer $NS/applets/Scribble/Scribble.html

and press the Enter key.

Wrapper
You can write a script to simplify launching applets. Here's an example
launch script:

  #!/bin/ksh

  ACT=$(echo $DISPLAY | awk -F':' '{print $1}')

  if ffl ! -f "/$1" “; then

   echo "Give full path: $1"

   exit 1

  fi

  if ffl "$1" = "$(basename $1 .html)" “; then

   echo "HTML file expected as an argument"

   exit 2

  fi

  rsh $ACT appletviewer $1

If you wanted to use the script to launch the Smooth  applet, you'd type
at the command line:

launch /usr/netstation/applets/smooth/Smooth.html

Running Java applications
Applications are even easier, since no HTML file is needed to launch them.

Note:  In the instructions below, $NS is the default directory for IBM Network
Station software, /usr/netstation  and $ACT is the hostname of the IBM Network
Station.

Application setup
To run the Java application Pipeline  on the IBM Network Station, the
Pipeline.class  Java class file must reside in a directory that is readable
by the client. For example:

$NS/applications/pipeline/Pipeline.class

HTML setup
Java applications do not require an HTML file.

Command
The JVM reads its Java classes and applications from the server via
TFTP or NFS. The JVM's classpath, when using JAVA, must be set on
the command line.
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In the example, this is the command:

rsh $ACT java -classpath

$NS/java:$NS/java/classes.zip:$NS/applications

$NS/applications/Pipeline &

Multiple applications
You cannot run multiple Java applications.

Wrapper
You can write a script to simplify application launching. In this example,
the run_Pipeline  script was created and saved in a new directory called
$NS/applications/bin . The script contains the following lines:

#!/bin/ksh

ACT=$(echo $DISPLAY | awk -F':' '{print $1}')

 NS=/usr/netstation

xset s off

rsh $ACT java -classpath $NS/java:$NS/java/classes.zip:$NS/applications \

 $NS/applications/Pipeline &

Notes:

1. The class path must include the /usr/netstation/java  directory, as
well as the file /usr/netstation/java/classes.zip .

2. Any other directories that your application accesses must also be
listed.

To use the script to launch the Pipeline  application, type at the
command line:

run_Pipeline

Since this is an application (not an applet), the appletviewer is not
launched; instead, a new window appears containing the Java
application.

Troubleshooting Java execution problems
If the Java applet or application does not start, bring up the console window by
pressing the Pause/Break key and select the Messages  button. Examine the
messages displayed in the messages section of the console window. The
messages displayed should give an indication of a problem found by the JVM in
executing your Java program.

 Error Messages:
� Can't find class ....

The JVM cannot find the class file requested by the Java applet or application.
If the error is returned while executing a Java application, inspect the classpath
specified in the calling program, and make sure that it includes the directories
which contain the class files associated with the program that is being
executed. If the classes are provided in a zip file, the fully qualified zip file
name must explicitly appear within the classpath.
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� Can't read zip file

Zip files cannot be read when TFTP is used as the file service. Take one of the
following actions:

– Have the system administrator configure the IBM Network Station to use
NFS for its file service.

– Have the system administrator install the class files expanded.

� Out of Memory

The heap size and/or the stack size may need to be adjusted for the
application or applet being run. The system administrator can do this via
configuration files loaded at boot time.
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Appendix C. More about CDE

What is CDE?
The Common Desktop Environment (CDE) desktop is an interactive graphical user
interface jointly developed by IBM, HP, Sun, and Novell for open systems. The
desktop is a rich and intuitive user interface based on X11 release 5 and OSF/Motif
1.2. It is designed for enterprise computing and scales across a variety of
platforms, appealing to a wide range of users from novice to expert.

CDE targets three key audiences: the end user, the system administrator, and the
application developer.

End users are presented with an easy-to-use interface, with emphasis on common
look, feel, and behavior. The desktop is both visually appealing and highly
customizable. Extensive online help has been provided to aid users in familiarizing
themselves with the desktop in minimal time.

System administrators will appreciate CDE's integrated approach to accessing
applications, whether they reside locally or on a remote host. CDE is also easy to
set up and configure, with most of the setup handled by tools which come
packaged with the desktop. Applications can be served from systems that do not
have CDE installed.

Application developers will find application integration to be straightforward and
painless. An application developer's toolkit comes standard with CDE 1.0 on AIX.
The toolkit includes libraries, custom widgets, header files, and application building
tools. The desktop also supports existing X Windows, and OSF/Motif applications.
See “CDE Infrastructure,” AIXpert, November 1996.

The scope of the desktop is broad, and encompasses core services, as well as
productivity tools and applications. The base support covers areas such as window
management, file management, customization, and online help. Advanced
programming services for interapplication communication include messaging,
drag/drop, data interchange, and session and workspace management. See
“Plug-and-Play,” AIXpert, April 1997.

 Why CDE?

Broad industry acceptance
AIX is X/Open CDE compliant.

Extensive online help system
The standard online help system is both system-wide and application-specific. With
the click of a mouse button, information about every feature of the desktop is
available. Applications can also be easily integrated with online help.
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Rich set of productivity tools
Many tools are provided standard with the desktop. Among these are a calendar,
text editor, mailer, print manager, terminal emulator, and icon editor.

 Multiple workspaces
One of the more popular features of the desktop is its multiple workspace
capability. Workspaces multiply the amount of display area available for windows.
Each workspace occupies the entire display, as though the display has multiple
screens.

Designed for enterprise computing
The desktop is designed to help you take advantage of distributed computing. For
example a user can add an appointment to another user's calendar or run an
application that resides on a remote machine.

 Standards Based
CDE is based on industry standards X/OPEN, X11 release 5, OSF/Motif 1.2, and
Spec 1170. Also a CDE Sample Implementation standard was established with the
release of CDE 1.0.

 Usability
CDE is based on a consistent user interface for appearance and behavior of the
desktop components. The design uses a graphical user interface and direct
manipulation approach. A cross-corporate team of usability professionals were
involved in the design of the CDE desktop. Additionally, extensive usability testing
was performed to verify the usability of the desktop.

Open Systems Based
Because CDE is X/Open-compliant, applications written for CDE can be easily
ported to run on all manufacturers' machines running the CDE desktop. This
means that developers don't have to create multiple versions of an application.

Check this URL for additional information about the CDE:

http://www.rs6ððð.ibm.com/software/OS/CDE/
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 Appendix D. CDE Action

ACTION NsConsole
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtinfbk
 LABEL  Console

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A console"

DESCRIPTION Network Station diagnostic terminal
}

ACTION NsTerms
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtinfbk
 LABEL  Terminals

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A term"

DESCRIPTION Network Station diagnostic terminal
}

ACTION NsSetup
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  DtCMtdo
 LABEL  Setup

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A setup"

DESCRIPTION Network Station setup
}

ACTION NsQuickSetup
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  DtCMtdo
 LABEL  Quick Setup

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A quicksetup"

DESCRIPTION Network Station quick setup
}

ACTION NsPref
{
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 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Fpstyle
 LABEL  Preferences

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A pref"

DESCRIPTION Network Station preferences
}

ACTION NsStats
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtload
 LABEL  Statistics

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A stats"

DESCRIPTION Network Station statistics
}

ACTION NsWm
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  DtDtwm.pm
 LABEL  Window Manager

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A wm"

DESCRIPTION Network Station local window manager
}

ACTION NsTelnet
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtterm
 LABEL  Telnet

EXEC_STRING /bin/ksh -c " \
   H="%"Hostname:"%"; \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A term -ctype telnet \$H"

DESCRIPTION Network Station telnet terminal emulator
}

ACTION Ns5250
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtterm
 LABEL  5250

EXEC_STRING /bin/ksh -c " \
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   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A ns5250"

DESCRIPTION Network Station 5250 terminal emulator
}

ACTION Ns3270
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtterm
 LABEL  3270

EXEC_STRING /bin/ksh -c " \
   H="%"Hostname:"%"; \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A ns3270 \$H"

DESCRIPTION Network Station 5250 terminal emulator
}

ACTION NsJVM
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  jInterpreter
 LABEL  JVM

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A jvm"

DESCRIPTION Network Station JVM
}

ACTION NsLogin
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  DtStart.pm
 LABEL  RFS Login

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A actlogin"

DESCRIPTION Network Station AS/400, MVS, & NT login
}

ACTION NsMemory
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtload
 LABEL  Memory

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A show memory"

DESCRIPTION Network Station memory usage
}
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ACTION NsVersion
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtinfbk
 LABEL  Version

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A show version"

DESCRIPTION Network Station version
}

ACTION NsConnections
{
 TYPE  COMMAND
 WINDOW_TYPE NO_STDIO
 ICON  Dtinfbk
 LABEL  Connections

EXEC_STRING /bin/ksh -c " \
   A= echo \$DISPLAY | awk -F':' '{print \$1}' ; \
   rsh \$A show connections"

DESCRIPTION Network Station connections
}

ACTION NsBootp
{
 TYPE COMMAND
 WINDOW_TYPE NO_STDIO
 ICON smit
 LABEL BootP

EXEC_STRING /bin/sh -c 'PATH=$PATH:/usr/netstation/bin smit bootp'
DESCRIPTION BootP configuration for the IBM Network Station

}
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 Appendix E. Notices

The following paragraph does not apply to the United Kingdom or any country
where such provisions are inconsistent with local law: THIS MANUAL IS
PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.

It is not warranted that the contents of this publication or the accompanying source
code examples, whether individually or as one or more groups, will meet your
requirements or that the publication or the accompanying source code examples
are error-free.

This publication could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. It is possible that this publication
may contain references to, or information about, products (machines and
programs), programming, or services that are not announced in your country. Such
references or information must not be construed to mean that such products,
programming, or services will be offered in your country. Any reference to a
licensed program in this publication is not intended to state or imply that you can
use only that licensed program. You can use any functionally equivalent program
instead.

The information provided regarding publications by other vendors does not
constitute an expressed or implied recommendation or endorsement of any
particular product, service, company or technology, but is intended simply as an
information guide that will give a better understanding of the options available to
you. The fact that a publication or company does not appear in this book does not
imply that it is inferior to those listed. The providers of this book take no
responsibility whatsoever with regard to the selection, performance, or use of the
publications listed herein.

NO WARRANTIES OF ANY KIND ARE MADE WITH RESPECT TO THE
CONTENTS, COMPLETENESS, OR ACCURACY OF THE PUBLICATIONS
LISTED HEREIN. ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE SPECIFICALLY
DISCLAIMED. This disclaimer does not apply to the United Kingdom or elsewhere
if inconsistent with local law.

Address comments to Publications Dept., Internal Zip 9561, 11400 Burnet Road,
Austin, Texas 78758-3493. To send comments electronically, use this commercial
internet address: aix6kpub@austin.ibm.com. Any information that you supply may
be used without incurring any obligation to you.

Copyright International Business Machines Corporation 1997. All rights reserved.

Notice to U.S. Government Users - Documentation Related to Restricted Rights -
Use, duplication or disclosure is subject to restrictions set forth in GSA ADP
Schedule Contract.
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 Appendix F. Trademarks

The following terms are trademarks or registered trademarks of the IBM
Corporation in the United States or other countries or both:

AIX is a registered trademark of International Business Machines Corporation.

AS/400 is a registered trademark of International Business Machines
Corporation.

IBM is a registered trademark of International Business Machines Corporation.

InfoExplorer is a trademark of International Business Machines Corporation.

PowerPC is a trademark of International Business Machines Corporation.

RS/6000 is a trademark of International Business Machines Corporation.

S/390 is a registered trademark of International Business Machines
Corporation.

The following terms are trademarks of other companies:

Java and Hot Java are trademarks of Sun Microsystems, Inc.

Motif is a trademark of Open Software Foundation, Inc.

OSF/Motif is a trademark of Open Software Foundation, Inc.

PostScript is a trademark of Adobe Systems Incorporated.

UNIX is a registered trademark in the United States and other countries
licensed exclusively through X/Open Company Limited.

X11 is a trademark of Massachusetts Institute of Technology.

X/Open is a trademark of X/Open Company Limited.

X Window System is a trademark of Massachusetts Institute of Technology.

Other company, product, and service names may be trademarks or service marks
of others.
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